TI Designs
Single-Phase AC and DC Power Monitor with Wire Resistance and EMI Capacitor Compensation

Design Features
- Measurement of
  - Voltage: Root Mean Square, THD, Fundamental
  - Current: Root Mean Square, THD, Fundamental
  - Power: Active, Reactive, Apparent, Fundamental Active
  - AC Frequency, Power Factor
- Measures Signal Phase AC and DC and Capable of Switch Between AC and DC Mode Automatically
- Capable of Doing EMI Filter Capacitor and Wire Resistance Compensation
- No Separate DC Calibration Required
- Readings Update Every Four AC Cycles or 80 ms in Case of DC Input
- Spy-Bi-Wire Debugging Interface
- Built-In Switching Mode Power Supply, RS-232 External Communication Interface, 7-in LEDs

Featured Applications
- Home Appliances
- UPS, Server, and PC Power Supplies
- Smart Plugs or Power Strip
- Solar Energy Inverter
- Electrical Vehicle Charger
- Home Monitoring, Security, and Automation

Design Resources
- TIDM-SERVER-PWR-MON: Design Page
- MSP430i2040: Product Folder
- EVM430:i2040SUBMTR: EVM Folder

ASK Our Analog Experts
WEBENCH® Calculator Tools

An IMPORTANT NOTICE at the end of this TI reference design addresses authorized use, intellectual property matters and other important disclaimers and information.
1 System Description

1.1 Cautions and Warnings

The EVM is designed to operate from AC supply or high voltage DC supply by professionals who have received appropriate technical training. Please read the safety related documents that come with the EVM package and user's guide before operating the EVM.

CAUTION
Read user guide before use.

CAUTION
Do not leave the EVM powered when unattended.

CAUTION
HOT SURFACE: Contact may cause burns. Do not touch.

CAUTION
HIGH VOLTAGE: Electric shock possible when connecting board to live wire. The board should be handled with care by a professional. For safety, use isolated equipment with overvoltage and overcurrent protection.

This document discusses an application of a single-phase AC and DC power monitor (or server power monitor) using a simple, low-cost Texas Instruments MCU MSP430i2040. The MSP430i2040 is a mixed signal microcontroller. The MCU integrates with four differential input 24-bit sigma-delta (SD24) A/D converters (ADCs) with programmable gain amplifier, a 16-bit hardware multiplier, an SPI communication interface, and an eUSCI A0 supports UART. The eUSCI B0 supports SPI, I2C, two 16-bit timer, and 12 GPIO pins in a 28-pin TSSOP or 16 GPIO pins in a 32-pin QFN package. The peripheral set is a good combination to measure electrical power.

This document uses the default firmware and the original EVM hardware design to describe the setup, operations, features, behaviors, functions, and interfacing. Proper functionality is not guaranteed if changes made to hardware or firmware.

For more information about the EVM, see the EVM430-i2040SUBMTR User’s Guide.
2 Design Features

2.1 Basic Operations

This design uses three SD24 ADCs on the MCU: one to measure voltage, one to measure current, and the other one connects to the built-in temperature sensor to measure temperature. The sigma-delta ADC runs approximately at a 1.024-MHz modulator frequency fixed by the hardware. The sample frequency derives from the modulator frequency divided by 128 equals 8 kHz, which give us a Nyquist bandwidth of 4 kHz. This bandwidth is sufficient to cover the 66th harmonic for 60-Hz AC. The 80th harmonic for 50-Hz AC frequency as a wider bandwidth is usually needed for server power monitoring due to the nature of the switching power supplies.

Figure 1 shows the system functional diagram. The two SD24 ADCs take samples from the voltage and the current channel with the (calibrated and programmed) fractional delay. The samples then pass through a DC removal filter. Each DC removal filter dynamically tracks the DC offset of the ADC and the signal by analyzing each sample and removes the DC (from signal and from ADC-DC offset) before passing the sample to further processing. If the operation is in DC mode, the DC removal filter only removes the DC offset of the ADC.

The current sample and the voltage sample then performs a square and accumulates to get the root mean square current ($I_{\text{RMS}}$) and voltage ($V_{\text{RMS}}$). The current sample also multiplies and accumulates with the voltage sample with proper additional phase delay (if needed) to get the active power ($P_{\text{active}}$) and with the corresponding 90-degree shifted sample to get the reactive power ($P_{\text{reactive}}$). The EVM then uses an internally generated pure sine wave amplitude and phase synchronized with the AC voltage input together with the 90 degree-shifted version to multiply and accumulate with the current sample to get the fundamental active and fundamental reactive power.

The cycle detection mechanism detects the presence of an AC signal by checking the number of zero crossings over a pre-defined time. If the number of zero crossings is less than the expected number of zero crossings minus 1, then the cycle is in DC mode; otherwise, the cycle is in AC mode. This mechanism works well for the frequency from 25 Hz when the pre-defined determination interval is set to 80 ms.

After four AC cycles (or 80 ms in DC mode), the system sets a flag to show results that need to process. The flag then triggers this system to perform the scaling and convert these accumulated values into values of proper unit (V, A, W, and so on).

![System Functional Diagram](image-url)
3 Block Diagram

Figure 2. System Block Diagram

3.1 Interface Circuit

The key factor of a successful and accurate metering circuit design very much depends on a good sampling circuit. The 24-bit sigma-delta ADC on the MSP430i2040, together with the on-chip programmable gain amplifier, provides the critical hardware for getting high quality AD conversion results from both the current and voltage sensor. Moreover, the interface circuit, the component selection, and the circuit layout also play a crucial role for a successful design.

Due to the nature of a sigma-delta ADC and of the voltage and current signals being measured, an external interface circuit is needed to interface the voltage and current to keep the sigma-delta ADC to work properly and provide proper filtering for a band of interest.

The hardware of the interface circuit consists of simple, passive components apart from the protection diode. Figure 3 shows the interface circuit designed. The top circuit is the interface to the voltage sensor and the bottom circuit is for the current sensor (or the shunt resistor).

In the current sensor interface circuit with R6 being the shunt sensor, D1 is the optional protection diode. The protection diode is not required unless, for example, a high shunt resistor value or a current transformer is in use instead of the current sensor, and the user anticipates a significant current surge to cause enough voltage across the sensor to damage the MCU.

L1, R9, and C9 forms a low pass filter having a bandwidth of a few MHz. The purpose of this filter is to reject radio frequency interference from going into the sigma-delta ADC. The filter formed by L2, R8, and C8 has the same characteristic, which is balanced for the differential signal. The filter formed by R9, R8, and C10 is a filter that gives a bandwidth of about 10 kHz, which is the filter for the band of interest.

The order of magnitude of these capacitors should be observed although the actual value of the capacitance is not that critical.
The voltage sensor interface is a resistor ladder. The ratio of the resistance in the resistor ladder allows up to 308-V AC and 420-V DC to be measured. The current sensor filter is similar except that the value of R10 is 100 Ω, not 1 kΩ. The reason for this is the voltage divider circuit has an equivalent source resistance \( \frac{990k}{1.5k + 990k} = 1.5k \) in series with R10. To balance the filter for the differential signal, the sensor uses a small R10 value. The combined effect is of similar value to R11. Although there is a slight mismatch using the designed value, this effect has no observable impact to accuracy.

![Block Diagram](image)

**Figure 3. Voltage and Current Sensor Interface Circuit**

### 3.2 Component Considerations

#### 3.2.1 Shunt Resistor

For accurate measurements, the choice of shunt is another important factor. In practice, a shunt of smaller value is a better choice. Smaller shunt values benefit the power dissipated on the shunt and the respective rise in temperature. The lower rise in temperature reduces the need for a very low temperature coefficient shunt resistor to sustain accuracy. However, using a small value shunt has a drawback as well in that the signal-to-noise ratio (SNR) of a small value shunt is worse than using a larger value one. In this sense, there may be chance that a shunt of higher value is desired, for example when measuring a very small current and the range of current to be measured are also in a small range. Consider these factors for this design: the maximum current, the current dynamic range, and the power dissipation.

In this application, the maximum current for each socket is 15 A, and the desired dynamic range of current keeping flat error percentage is 1000:1. Keep the power dissipated on the shunt resistor as small as possible.

To achieve the best accuracy, have the shunt sensor signal use the whole input range of the SD24. Because the SD24 ADC has an input range of 900 mV at x1 gain, using a x16 gain the input range is

\[
\frac{900}{16} = 56.25 \text{mV}_{\text{RMS}}
\]

With this number, a 2-mΩ shunt resistance suits this input up to 19.5 A. Due to the limited area of copper attached to the shunt resistor, however, use a smaller valued shunt to keep the heat accumulation on the shunt resistor low, then choose a 0.5-mΩ shunt resistance.

In addition to value, the physical size of the shunt is also an important factor to accuracy—not the size directly, but the heat generated when current flows. A smaller sized shunt heats up more easily due to the limited surface area. If there is significant current to flow through the shunt, have a large enough sized shunt and sufficient ventilation on the PCB to prevent heat being accumulated. In this design, a 2512 size shunt is choose. At 0.5-mΩ, the power dissipate on the shunt at maximum current is \( 16^2 \times 0.5 = 0.128 \text{ W} \), which is about one-eighth the rated power of a 2512 size 1-W shunt resistor.
3.2.2 Voltage Divider Circuit

For the voltage sensor circuit, the matter is a little simpler. In this design, the major consideration is that the voltage divider should be able to prevent arcing between the terminals. To reduce the voltage difference between resistor terminals, this design uses four resistors (instead of 2) to form the voltage divider (R1, R13, and R14 are 330 kΩ, and R15 is 1.5 kΩ). Then the voltage across R1, R13, and R14 each take about one-third of the AC voltage. Now at 220-V input, each resistor has a voltage drop of about 75 V. Using the 2512 resistor for R1, R13, and R14 then further separate the live voltage and R15.

The installation of D8 in the voltage sensor circuit is more important than D1 in the current circuit. The reason is that the resistor ladder on the voltage sensor circuit is more likely to see a voltage surge across R15 high enough to damage the MCU. If R15 is open circuit or in bad contact, causing a higher resistance the voltage across the input of the voltage channel ADC also damages the MCU.

4 Software Description

4.1 Firmware Structure

The firmware is designed to use a layered approach, isolating the user from the details of metrology and the associated computations involved to simplify the programming work.

In user's view, the firmware is partitioned into three main blocks:

- The application, which contains the function to perform system setup and initialization, main loop, communication protocol and command handling, non-volatile parameters preset, and manipulation.
- The toolkit packaged, which is packed into a library named “emeter-toolkit-i2041.r43”, contains low-level computation routines.
- The metrology computation engine, which is packaged into a library named “emeter-metrology-i2041.r43”, contains the function for ADC setup and initialization, sample-based background processing, reporting cycle-based foreground processing, and result reading API.

NOTE: This package does not include the source code of this library. Contact a local Texas Instruments Sales Team if the source code is needed.
4.2 Metrology Computation Engine

The metrology computation engine performs the actual sampling and computation based on the information collected from the voltage and current ADC channels. The engine acts in a time-critical background process and a less time-critical foreground process.

The background process is triggered by the ADC at the sample rate. This process runs in the interrupt services routine of the ADC and is processed automatically.

The foreground process is triggered by the completion of background process at the reporting and update rate. The background process sets the flag PHASE_STATUS_NEW_LOG in the variable phase_state to indicate that data is ready to be processed by the foreground. The application then needs to monitor this flag to trigger the foreground process by calling to calculate_phase_readings()

In the actual computation, use the following formulas in the metrology computation:

\[
V_{\text{RMS fund}} = V_{\text{GAIN}} \times \sqrt{\frac{1}{N} \sum_{i=1}^{N} V_{\text{samp}}(i) \times V_{\text{pure}}(i)}
\]

\[
I_{\text{RMS fund}} = I_{\text{GAIN}} \times \sqrt{\frac{1}{N} \sum_{i=1}^{N} I_{\text{amp}}(i) \times I_{\text{amp}}(i)}
\]

\[
P_{\text{active fund}} = P_{\text{GAIN}} \times \frac{1}{N} \sum_{i=1}^{N} V_{\text{amp}}(i) \times I_{\text{amp}}(i)
\]

\[
P_{\text{reactive fund}} = P_{\text{reactive}} \times \frac{1}{N} \sum_{i=1}^{N} V_{\text{amp}}(i) \times I_{\text{amp}}(i)
\]

\[
P_{\text{apparent}} = V_{\text{RMS}} \times I_{\text{RMS}}
\]

\[
\text{PF} = \cos \phi = \frac{P_{\text{active}}}{P_{\text{apparent}}}
\]

\[
V_{\text{THD}} = \sqrt{\frac{V_{\text{RMS fund}}^2 - V_{\text{RMS fund}}^2}{V_{\text{RMS fund}}^2}}
\]

\[
I_{\text{THD}} = \sqrt{\frac{I_{\text{RMS fund}}^2 - I_{\text{RMS fund}}^2}{I_{\text{RMS fund}}^2}}
\]
4.2.1 Background Process

The background performs a straightforward, time-critical, sample-based process. The process starts by an interrupting trigger at the sample rate. The background process then

- Captures data from voltage and current ADC channels
- Performs voltage sample processing and line resistance compensation
- Performs current sample processing and capacitance compensation
- Performs power processing
- Performs fundamental power processing
- Performs line frequency processing and AC/DC mode test and switching
- Triggers the foreground process

4.2.2 Foreground Process

After reaching the report cycle, the background sets the flag PHASE_STATUS_NEW_LOG. The user main loop checks the status of this flag and calls to the foreground process calculate_phase_readings() to perform the rest of the computation and deliver the measurement readings, including

- Power processing
  1. Calculate active power and reactive power
  2. Calculate fundamental active and fundamental reactive power
- Voltage processing
  1. Calculate the RMS voltage and fundamental RMS voltage
- Current processing
  1. Calculate the RMS current and fundamental RMS current
  2. Calculate the apparent power
- Other processing
  1. Calculate the power factor
  2. Calculate the frequency of the AC line
5 Test Setup

5.1 Apparatus

The following list of instruments help calibrate and test the EVM (See the instrument link in Section 8):

- AC meter test set
- AC source that could output sufficient power to drive the load at a rated frequency (for example, 50 to 60 Hz) and a rated voltage (for example, 110 to 220 V) with a variable AC load or UUT. If DC measurement is needed, use a variable DC load or UUT. Alternatively, an AC test set could generate the rated loading
- A reference meter that could read AC parameters based on the voltage, current, and phase setting from the AC meter test set

5.2 Setup

Figure 4. Setup
### Table 1. Output C PF = 1, Cal at 7.50212 A, 1650.7 W

<table>
<thead>
<tr>
<th>CURRENT REF</th>
<th>CURRENT READ</th>
<th>CURRENT ERROR</th>
<th>CURRENT %</th>
<th>POWER REF</th>
<th>POWER READ</th>
<th>POWER ERROR</th>
<th>POWER %</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.014555</td>
<td>0.01476</td>
<td>0.000205</td>
<td>1.408%</td>
<td>3.202</td>
<td>3.213</td>
<td>0.011</td>
<td>0.355%</td>
</tr>
<tr>
<td>0.029637</td>
<td>0.029737</td>
<td>0.0001</td>
<td>0.339%</td>
<td>6.517</td>
<td>6.515</td>
<td>-0.002</td>
<td>-0.029%</td>
</tr>
<tr>
<td>0.074836</td>
<td>0.07495</td>
<td>0.000114</td>
<td>0.152%</td>
<td>16.579</td>
<td>16.615</td>
<td>0.036</td>
<td>0.217%</td>
</tr>
<tr>
<td>0.145378</td>
<td>0.145391</td>
<td>0.000013</td>
<td>0.009%</td>
<td>31.984</td>
<td>31.992</td>
<td>0.009</td>
<td>0.027%</td>
</tr>
<tr>
<td>0.295964</td>
<td>0.295992</td>
<td>0.000028</td>
<td>0.009%</td>
<td>65.114</td>
<td>65.168</td>
<td>0.054</td>
<td>0.083%</td>
</tr>
<tr>
<td>0.747332</td>
<td>0.747569</td>
<td>0.000237</td>
<td>0.032%</td>
<td>165.104</td>
<td>165.256</td>
<td>0.152</td>
<td>0.092%</td>
</tr>
<tr>
<td>1.50005</td>
<td>1.5</td>
<td>-0.00005</td>
<td>-0.003%</td>
<td>330.06</td>
<td>330.314</td>
<td>0.254</td>
<td>0.077%</td>
</tr>
<tr>
<td>2.98846</td>
<td>2.989</td>
<td>0.00054</td>
<td>0.18%</td>
<td>662.136</td>
<td>662.586</td>
<td>0.45</td>
<td>0.068%</td>
</tr>
<tr>
<td>7.50239</td>
<td>7.5</td>
<td>-0.00239</td>
<td>-0.032%</td>
<td>1650.38</td>
<td>1650.779</td>
<td>0.399</td>
<td>0.024%</td>
</tr>
<tr>
<td>14.35</td>
<td>14.32</td>
<td>-0.03</td>
<td>-0.209%</td>
<td>3090.24</td>
<td>3084.544</td>
<td>-0.596</td>
<td>-0.184%</td>
</tr>
<tr>
<td>19.3214</td>
<td>19.242</td>
<td>-0.0794</td>
<td>-0.411%</td>
<td>4162.29</td>
<td>4143</td>
<td>-19.29</td>
<td>-0.463%</td>
</tr>
</tbody>
</table>

### Table 2. Output C PF = 0.5 L, Cal at 7.50212 A, 1650.7 W

<table>
<thead>
<tr>
<th>CURRENT REF</th>
<th>CURRENT READ</th>
<th>CURRENT ERROR</th>
<th>CURRENT %</th>
<th>POWER REF</th>
<th>POWER READ</th>
<th>POWER ERROR</th>
<th>POWER %</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.014558</td>
<td>0.014654</td>
<td>0.000096</td>
<td>0.659%</td>
<td>1.555</td>
<td>1.559</td>
<td>0.004</td>
<td>0.257%</td>
</tr>
<tr>
<td>0.029628</td>
<td>0.029774</td>
<td>0.000146</td>
<td>0.492%</td>
<td>3.173</td>
<td>3.168</td>
<td>-0.005</td>
<td>-0.158%</td>
</tr>
<tr>
<td>0.074823</td>
<td>0.074824</td>
<td>0.000001</td>
<td>0.001%</td>
<td>8.037</td>
<td>8.055</td>
<td>0.018</td>
<td>0.218%</td>
</tr>
<tr>
<td>0.145166</td>
<td>0.145141</td>
<td>-0.000025</td>
<td>-0.017%</td>
<td>13.287</td>
<td>13.298</td>
<td>0.011</td>
<td>0.083%</td>
</tr>
<tr>
<td>0.295495</td>
<td>0.295481</td>
<td>-0.000014</td>
<td>-0.005%</td>
<td>27.587</td>
<td>27.589</td>
<td>0.002</td>
<td>0.007%</td>
</tr>
<tr>
<td>0.747391</td>
<td>0.747393</td>
<td>0.000002</td>
<td>0.000%</td>
<td>71.399</td>
<td>71.492</td>
<td>0.093</td>
<td>0.130%</td>
</tr>
<tr>
<td>1.5001</td>
<td>1.5</td>
<td>-0.0001</td>
<td>-0.007%</td>
<td>165.134</td>
<td>165.379</td>
<td>0.245</td>
<td>0.148%</td>
</tr>
<tr>
<td>2.98839</td>
<td>2.989</td>
<td>0.00061</td>
<td>0.020%</td>
<td>319.346</td>
<td>319.745</td>
<td>0.399</td>
<td>0.125%</td>
</tr>
<tr>
<td>7.40232</td>
<td>7.4</td>
<td>-0.00232</td>
<td>-0.031%</td>
<td>596.562</td>
<td>596.954</td>
<td>0.392</td>
<td>0.066%</td>
</tr>
<tr>
<td>14.3712</td>
<td>14.354</td>
<td>-0.0172</td>
<td>-0.120%</td>
<td>890.268</td>
<td>889.965</td>
<td>-0.303</td>
<td>-0.034%</td>
</tr>
<tr>
<td>20.0216</td>
<td>19.914</td>
<td>-0.1076</td>
<td>-0.537%</td>
<td>2197.23</td>
<td>2187.52</td>
<td>-9.710</td>
<td>-0.442%</td>
</tr>
</tbody>
</table>

### Table 3. Output C PF = 0.5 C, Cal at 7.50212 A, 1650.7 W

<table>
<thead>
<tr>
<th>CURRENT REF</th>
<th>CURRENT READ</th>
<th>CURRENT ERROR</th>
<th>CURRENT %</th>
<th>POWER REF</th>
<th>POWER READ</th>
<th>POWER ERROR</th>
<th>POWER %</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.014543</td>
<td>0.014671</td>
<td>0.000128</td>
<td>0.879%</td>
<td>1.659</td>
<td>1.652</td>
<td>-0.007</td>
<td>-0.422%</td>
</tr>
<tr>
<td>0.029624</td>
<td>0.029638</td>
<td>0.000014</td>
<td>0.046%</td>
<td>3.388</td>
<td>3.39</td>
<td>0.002</td>
<td>0.056%</td>
</tr>
<tr>
<td>0.074827</td>
<td>0.074848</td>
<td>0.000021</td>
<td>0.029%</td>
<td>8.525</td>
<td>8.537</td>
<td>0.012</td>
<td>0.141%</td>
</tr>
<tr>
<td>0.145314</td>
<td>0.145267</td>
<td>-0.000047</td>
<td>-0.032%</td>
<td>18.491</td>
<td>18.503</td>
<td>0.012</td>
<td>0.068%</td>
</tr>
<tr>
<td>0.295834</td>
<td>0.295752</td>
<td>-0.000082</td>
<td>-0.028%</td>
<td>37.381</td>
<td>37.391</td>
<td>0.01</td>
<td>0.027%</td>
</tr>
<tr>
<td>0.747077</td>
<td>0.747067</td>
<td>-0.000001</td>
<td>-0.001%</td>
<td>94.044</td>
<td>94.03</td>
<td>-0.014</td>
<td>-0.015%</td>
</tr>
<tr>
<td>1.48145</td>
<td>1.481</td>
<td>-0.00045</td>
<td>-0.030%</td>
<td>171.561</td>
<td>171.526</td>
<td>-0.035</td>
<td>-0.020%</td>
</tr>
<tr>
<td>2.98851</td>
<td>2.989</td>
<td>0.00049</td>
<td>0.016%</td>
<td>345.256</td>
<td>345.311</td>
<td>0.055</td>
<td>0.016%</td>
</tr>
<tr>
<td>7.40175</td>
<td>7.399</td>
<td>-0.00275</td>
<td>-0.037%</td>
<td>1025.61</td>
<td>1025.054</td>
<td>-0.556</td>
<td>-0.054%</td>
</tr>
<tr>
<td>14.3347</td>
<td>14.318</td>
<td>-0.0167</td>
<td>-0.117%</td>
<td>2196.37</td>
<td>2190.308</td>
<td>-6.062</td>
<td>-0.276%</td>
</tr>
<tr>
<td>19.304</td>
<td>19.241</td>
<td>-0.063</td>
<td>-0.326%</td>
<td>2965.78</td>
<td>2951.4</td>
<td>-14.38</td>
<td>-0.485%</td>
</tr>
</tbody>
</table>
NOTE: From the above graph, the error begins to go negative the higher current. This phenomenon is due to the shunt heating up by the current flowing through the traces on the board. At a low current, the higher error is mostly caused by noise, causing unstable readings.
Table 4. Typical Accuracy versus Temperature

<table>
<thead>
<tr>
<th>TEMP (°C)</th>
<th>V</th>
<th>VREF</th>
<th>V%</th>
<th>I</th>
<th>IREF</th>
<th>I%</th>
<th>P</th>
<th>PREF</th>
<th>P%</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>219.786</td>
<td>219.991</td>
<td>-0.093%</td>
<td>5.005</td>
<td>5.000</td>
<td>0.097%</td>
<td>1100.730</td>
<td>1099.940</td>
<td>0.072%</td>
</tr>
<tr>
<td>5</td>
<td>219.728</td>
<td>219.978</td>
<td>-0.114%</td>
<td>5.005</td>
<td>5.000</td>
<td>0.088%</td>
<td>1099.470</td>
<td>1099.860</td>
<td>-0.035%</td>
</tr>
<tr>
<td>10</td>
<td>219.801</td>
<td>219.992</td>
<td>-0.087%</td>
<td>5.005</td>
<td>5.000</td>
<td>0.082%</td>
<td>1100.050</td>
<td>1100.040</td>
<td>0.001%</td>
</tr>
<tr>
<td>15</td>
<td>219.839</td>
<td>219.997</td>
<td>-0.072%</td>
<td>5.004</td>
<td>5.000</td>
<td>0.072%</td>
<td>1100.110</td>
<td>1100.020</td>
<td>0.008%</td>
</tr>
<tr>
<td>20</td>
<td>219.896</td>
<td>220.013</td>
<td>-0.053%</td>
<td>5.003</td>
<td>5.000</td>
<td>0.053%</td>
<td>1100.120</td>
<td>1099.920</td>
<td>0.018%</td>
</tr>
<tr>
<td>25</td>
<td>219.883</td>
<td>219.954</td>
<td>-0.032%</td>
<td>5.002</td>
<td>5.000</td>
<td>0.025%</td>
<td>1100.050</td>
<td>1099.830</td>
<td>0.020%</td>
</tr>
<tr>
<td>30</td>
<td>219.951</td>
<td>220.021</td>
<td>-0.032%</td>
<td>4.998</td>
<td>5.000</td>
<td>-0.040%</td>
<td>1099.680</td>
<td>1099.930</td>
<td>-0.023%</td>
</tr>
<tr>
<td>35</td>
<td>219.990</td>
<td>220.060</td>
<td>-0.032%</td>
<td>4.996</td>
<td>5.000</td>
<td>-0.088%</td>
<td>1099.290</td>
<td>1099.960</td>
<td>-0.061%</td>
</tr>
<tr>
<td>40</td>
<td>220.012</td>
<td>220.021</td>
<td>-0.004%</td>
<td>4.993</td>
<td>5.000</td>
<td>-0.142%</td>
<td>1098.910</td>
<td>1100.060</td>
<td>-0.105%</td>
</tr>
<tr>
<td>45</td>
<td>220.060</td>
<td>220.054</td>
<td>0.003%</td>
<td>4.991</td>
<td>5.000</td>
<td>-0.193%</td>
<td>1098.330</td>
<td>1099.840</td>
<td>-0.137%</td>
</tr>
<tr>
<td>50</td>
<td>220.054</td>
<td>220.053</td>
<td>0.000%</td>
<td>4.988</td>
<td>5.000</td>
<td>-0.256%</td>
<td>1097.580</td>
<td>1099.920</td>
<td>-0.213%</td>
</tr>
<tr>
<td>55</td>
<td>220.026</td>
<td>219.996</td>
<td>0.014%</td>
<td>4.983</td>
<td>5.000</td>
<td>-0.343%</td>
<td>1096.890</td>
<td>1099.910</td>
<td>-0.275%</td>
</tr>
<tr>
<td>60</td>
<td>220.050</td>
<td>220.027</td>
<td>0.010%</td>
<td>4.979</td>
<td>5.000</td>
<td>-0.427%</td>
<td>1095.800</td>
<td>1099.890</td>
<td>-0.372%</td>
</tr>
<tr>
<td>65</td>
<td>220.009</td>
<td>220.051</td>
<td>-0.019%</td>
<td>4.974</td>
<td>5.000</td>
<td>-0.522%</td>
<td>1094.700</td>
<td>1100.020</td>
<td>-0.484%</td>
</tr>
<tr>
<td>70</td>
<td>219.968</td>
<td>219.995</td>
<td>-0.012%</td>
<td>4.969</td>
<td>5.000</td>
<td>-0.630%</td>
<td>1093.210</td>
<td>1099.940</td>
<td>-0.612%</td>
</tr>
<tr>
<td>75</td>
<td>219.896</td>
<td>219.973</td>
<td>-0.035%</td>
<td>4.969</td>
<td>5.000</td>
<td>-0.629%</td>
<td>1093.060</td>
<td>1100.030</td>
<td>-0.634%</td>
</tr>
<tr>
<td>80</td>
<td>219.892</td>
<td>219.952</td>
<td>-0.027%</td>
<td>4.969</td>
<td>5.000</td>
<td>-0.637%</td>
<td>1092.600</td>
<td>1099.960</td>
<td>-0.669%</td>
</tr>
<tr>
<td>85</td>
<td>219.895</td>
<td>219.957</td>
<td>-0.028%</td>
<td>4.968</td>
<td>5.004</td>
<td>-0.704%</td>
<td>1092.840</td>
<td>1099.910</td>
<td>-0.643%</td>
</tr>
</tbody>
</table>

Figure 6. Typical Accuracy versus Temperature

NOTE: From the above graph, the error begins to go negative the higher temperature. This phenomenon is due to the board heating up and the combined temperature coefficient of the whole board is in effect.
7 Design Files

7.1 Schematics

To download the schematics, see the design files at TIDM-SERVER-PWR-MON.
7.2 Bill of Materials

To download the bill of materials (BOM), see the design files at [TIDM-SERVER-PWR-MON](#).

Table 5. BOM

<table>
<thead>
<tr>
<th>ITEM</th>
<th>QTY</th>
<th>REFERENCE</th>
<th>VALUE</th>
<th>PART DESCRIPTION</th>
<th>MANUFACTURER</th>
<th>MANUFACTURER PART NUMBER</th>
<th>PCB FOOTPRINT</th>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>PCB</td>
<td></td>
<td>Printed circuit board</td>
<td></td>
<td>Printed circuit board</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>C4</td>
<td>470 nF</td>
<td>CAP, CERM, 470 nF</td>
<td>Taiyo Yuden</td>
<td>EMK107F474ZA-T</td>
<td>0603</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>R18</td>
<td>2.2 k</td>
<td>RES, 2.2 kΩ, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ222V</td>
<td>0603</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>R19</td>
<td>Open</td>
<td>RES, open ohm, x%, xW, [PackageReference]</td>
<td></td>
<td></td>
<td>0603</td>
<td>Open</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>R20</td>
<td>1 k</td>
<td>RES, 1 kΩ, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ102V</td>
<td>0603</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>R21</td>
<td>2.2 k</td>
<td>RES, 2.2 kΩ, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ222V</td>
<td>0603</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>R22</td>
<td>68</td>
<td>RES, 68 Ω, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ680V</td>
<td>0603</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>R23</td>
<td>1 k</td>
<td>RES, 1 kΩ, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ102V</td>
<td>0603</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>R24</td>
<td>10 k</td>
<td>RES, 10 kΩ, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ103V</td>
<td>0603</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>10</td>
<td>1</td>
<td>R25</td>
<td>1.5 k</td>
<td>RES, 1.5 kΩ, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ152V</td>
<td>0603</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td>R26</td>
<td>220</td>
<td>RES, 220 Ω, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-3GEYJ221V</td>
<td>0603</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>12</td>
<td>4</td>
<td>C8, C9, C12, C13</td>
<td>47 pF</td>
<td>CAP, CERM, 47 pF, 50 V, ±5%, C0G/NP0, 0402</td>
<td>Murata Electronics North America</td>
<td>GRM1555C1H470JJ01</td>
<td>0402</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>13</td>
<td>2</td>
<td>C10, C14</td>
<td>0.015 μF</td>
<td>CAP, CERM, 0.015 μF, 50 V, ±10%, X7R, 0402</td>
<td>Murata Electronics North America</td>
<td>GRM155R71H153KA12D</td>
<td>0402</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>14</td>
<td>2</td>
<td>C11, C20</td>
<td>0.1 μF</td>
<td>CAP, CERM, 0.1 μF, 10 V, ±10%, X5R, 0402</td>
<td>TDK Corporation</td>
<td>C1005X5R1A104K</td>
<td>0402</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>15</td>
<td>1</td>
<td>C19</td>
<td>10 μF</td>
<td>CAP, TANT, 10 μF, 10 V, ±20%, 2.5 Ω, 3528-21 SMD</td>
<td>Vishay Sprague</td>
<td>293D106X0010B2TE3</td>
<td>3528-21</td>
<td>Product Page Link</td>
</tr>
</tbody>
</table>
### Table 5. BOM (continued)

<table>
<thead>
<tr>
<th>ITEM</th>
<th>QTY</th>
<th>REFERENCE</th>
<th>VALUE</th>
<th>MANUFACTURER</th>
<th>MANUFACTURER PARTNUMBER</th>
<th>PCB FOOTPRINT</th>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>1</td>
<td>C21</td>
<td>2.2 n</td>
<td>AVX Corporation</td>
<td>0805ZC222JAT2A</td>
<td>0805</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>17</td>
<td>2</td>
<td>C24, C25</td>
<td>0.1 µF</td>
<td>TDK Corporation</td>
<td>C1608X7R1H104K</td>
<td>0603</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>18</td>
<td>2</td>
<td>C26, C27</td>
<td>10 µF</td>
<td>AVX Corporation</td>
<td>F931D106KAA</td>
<td>7343-43</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>19</td>
<td>1</td>
<td>C28</td>
<td>220 µF</td>
<td>AVX Corporation</td>
<td>TCJB227M006R0200</td>
<td>7343-31</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>20</td>
<td>2</td>
<td>D1, D8</td>
<td></td>
<td>Littelfuse Inc</td>
<td>SMAJ5.0CA</td>
<td>DSC-C2/X1.8</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>21</td>
<td>4</td>
<td>D2, D3, D4, D5</td>
<td></td>
<td>Vishay Semiconductor Diodes Division</td>
<td>LL103A</td>
<td>SOD-80</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>22</td>
<td>1</td>
<td>D6</td>
<td></td>
<td>Littelfuse Inc</td>
<td>V320SM7</td>
<td>V320SM7</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>23</td>
<td>1</td>
<td>D7</td>
<td>7 V</td>
<td>Diodes Incorporated</td>
<td>SMBJ7.0A-13-F</td>
<td>SMB</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>24</td>
<td>1</td>
<td>FR</td>
<td>Fuse, 1 A, 125 V, SMD</td>
<td>Cooper Bussmann</td>
<td>6125FA1A</td>
<td>6125FA</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>25</td>
<td>4</td>
<td>H1, H2, H3, H4</td>
<td>Machine screw, round, #4-40 x 1/4, nylon, Philips panhead</td>
<td>NY PMS 440 0025 PH</td>
<td>NY PMS 440 0025 PH</td>
<td>Not populated</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>4</td>
<td>H5, H6, H7, H8</td>
<td>Standoff, Hex, 0.5&quot;L #4-40 Nylon</td>
<td></td>
<td>1902C</td>
<td>Keystone_1902C</td>
<td>Not populated</td>
</tr>
<tr>
<td>27</td>
<td>1</td>
<td>J1</td>
<td></td>
<td>Hole for Banana Socket</td>
<td>LIVE_IN</td>
<td></td>
<td>N/A (3.5-mm diameter through hole only, no component populated)</td>
</tr>
<tr>
<td>28</td>
<td>1</td>
<td>J2</td>
<td></td>
<td>Hole for Banana Socket</td>
<td>LIVE_OUT</td>
<td></td>
<td>N/A (3.5-mm diameter through hole only, no component populated)</td>
</tr>
<tr>
<td>29</td>
<td>1</td>
<td>J3</td>
<td></td>
<td>Hole for Banana Socket</td>
<td>NEUTRAL_IN</td>
<td></td>
<td>N/A (3.5-mm diameter through hole only, no component populated)</td>
</tr>
<tr>
<td>30</td>
<td>1</td>
<td>J4</td>
<td></td>
<td>Hole for Banana Socket</td>
<td>NEUTRAL_OUT</td>
<td></td>
<td>N/A (3.5-mm diameter through hole only, no component populated)</td>
</tr>
<tr>
<td>31</td>
<td>1</td>
<td>J5</td>
<td>Header, TH, 100 mil, 2×2, gold plated, 230 mil above insulator</td>
<td>TE Connectivity</td>
<td>TSW-102-07-G-D</td>
<td>TSW-102-07-G-D</td>
<td>Product Page Link</td>
</tr>
</tbody>
</table>

Machine screw, round, #4-40 x 1/4, nylon, Philips panhead

Machine screw, round, #4-40 x 1/4, nylon, Philips panhead

Header, TH, 100 mil, 2×2, gold plated, 230 mil above insulator

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Product Page Link

Copyright © 2014, Texas Instruments Incorporated
### Table 5. BOM (continued)

<table>
<thead>
<tr>
<th>ITEM</th>
<th>QTY</th>
<th>REFERENCE</th>
<th>VALUE</th>
<th>PART DESCRIPTION</th>
<th>MANUFACTURER</th>
<th>MANUFACTURER PARTNUMBER</th>
<th>PCB FOOTPRINT</th>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>1</td>
<td>J6</td>
<td></td>
<td></td>
<td>Sullins Connector Solutions</td>
<td>1.27mm pitch socket</td>
<td>6-pin header (1.27mm)</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>33</td>
<td>1</td>
<td>J7</td>
<td></td>
<td>Receptacle assembly, 9 position, right angle</td>
<td>TE Connectivity</td>
<td>D Connector 9</td>
<td>DSUB1.385-2H9</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>34</td>
<td>1</td>
<td>J8</td>
<td>1 x 3</td>
<td>Header, TH, 100 mil, 1×3, gold plated, 230 mil above insulator</td>
<td>Sullins Connector Solutions</td>
<td>PBC03SAAN</td>
<td>PBC03SAAN</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>35</td>
<td>1</td>
<td>J9</td>
<td></td>
<td>Header, 4-Pin 100 mil 1×4</td>
<td>TE Connectivity</td>
<td>Header 4</td>
<td>A31114-ND</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>36</td>
<td>2</td>
<td>L1, L2</td>
<td></td>
<td>Inductor, [Technology], [Material], xxuH, xxA, x.xx ohm, [MountType]</td>
<td>Murata Electronics North America</td>
<td>BLM21BD121SN1</td>
<td>0805</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>37</td>
<td>1</td>
<td>LBL1</td>
<td></td>
<td>Thermal transfer printable labels, 0.650&quot; W x 0.200&quot; H - 10,000 per roll</td>
<td></td>
<td></td>
<td>Size: 0.65&quot; x 0.20 &quot; Label_650x200</td>
<td>Not populated</td>
</tr>
<tr>
<td>38</td>
<td>2</td>
<td>LED1, LED5</td>
<td></td>
<td>Red</td>
<td>Lite-On Inc</td>
<td>LTST-C170KRKT</td>
<td>0805-LED</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>39</td>
<td>2</td>
<td>LED2, LED6</td>
<td></td>
<td>Green</td>
<td>Lite-On Inc</td>
<td>LTST-S220KGKT</td>
<td>0805-LED</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>40</td>
<td>2</td>
<td>LED3, LED7</td>
<td></td>
<td>Blue</td>
<td>Lite-On Inc</td>
<td>LTST-C170TBKT</td>
<td>0805-LED</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>41</td>
<td>1</td>
<td>LED4</td>
<td></td>
<td>White</td>
<td>Lite-On Inc</td>
<td>LTW-170TK</td>
<td>0805-LED</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>42</td>
<td>1</td>
<td>P1</td>
<td></td>
<td>Header, 7-pin, dual row</td>
<td>TE Connectivity</td>
<td>A104860-ND</td>
<td>2X7BOXHEADER</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>43</td>
<td>2</td>
<td>Q1, Q2</td>
<td>0.075 V</td>
<td>Transistor, PNP, 45 V, 0.1 A, SOT-23</td>
<td>Micro Commercial Co</td>
<td>BC857B</td>
<td>SOT-23</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>44</td>
<td>3</td>
<td>R1, R13, R14</td>
<td>330 k</td>
<td>RES, 330 kΩ, 1%, 1 W, 2010, RES, 330 kΩ, 5%, 1 W, 2010</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-S1DF3303U</td>
<td>2010M</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>45</td>
<td>1</td>
<td>R15</td>
<td>1.5 k</td>
<td>RES, 1.5 kΩ, 1%, 1 W, 2010, RES, 330 kΩ, 5%, 1 W, 2010</td>
<td>Rohm Semiconductor</td>
<td>MCR50JZHF1501</td>
<td>2010M</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>46</td>
<td>7</td>
<td>R2, R3, R4, R5, R7, R12, R17</td>
<td>390</td>
<td>RES, 390 Ω, 5%, 0.125 W, 0805</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-6GEYJ391V</td>
<td>0805</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>47</td>
<td>1</td>
<td>R6</td>
<td>500 µΩ</td>
<td>Shunt resistor</td>
<td>International Resistive</td>
<td>ULRB12512R0005FLFSLT</td>
<td>Current Sensing Pad</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>48</td>
<td>3</td>
<td>R8, R9, R11</td>
<td>1.00 k</td>
<td>RES, 1.00 kΩ, 1%, 0.063 W, 0402</td>
<td>Vishay Dale</td>
<td>CRCW04021K00FKE</td>
<td>0402</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>49</td>
<td>1</td>
<td>R10</td>
<td>100</td>
<td>RES, 100 Ω, 1%, 0.063 W, 0402</td>
<td>Vishay Dale</td>
<td>CRCW0402100RFKE</td>
<td>0402</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>50</td>
<td>1</td>
<td>R16</td>
<td>47 k</td>
<td>RES, 47 kΩ, 5%, 0.063 W, 0402</td>
<td>Vishay Dale</td>
<td>CRCW04024K70JNED</td>
<td>0402</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>51</td>
<td>7</td>
<td>R27, R28, R29, R30, R31, R36, RA3</td>
<td>Open</td>
<td>RES, open Ω, x%,</td>
<td></td>
<td></td>
<td>Open</td>
<td>Open</td>
</tr>
<tr>
<td>52</td>
<td>1</td>
<td>R32</td>
<td>1.5 k</td>
<td>RES, 1.5 kΩ, x%,</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-6GEYJ152V</td>
<td>0805</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>ITEM</td>
<td>QTY</td>
<td>REFERENCE</td>
<td>VALUE</td>
<td>PART DESCRIPTION</td>
<td>MANUFACTURER</td>
<td>MANUFACTURER PARTNUMBER</td>
<td>PCB FOOTPRINT</td>
<td>NOTE</td>
</tr>
<tr>
<td>------</td>
<td>-----</td>
<td>-----------</td>
<td>-------</td>
<td>------------------</td>
<td>--------------</td>
<td>------------------------</td>
<td>---------------</td>
<td>------</td>
</tr>
<tr>
<td>53</td>
<td>1</td>
<td>R33</td>
<td>1.5 k</td>
<td>RES, 1.5 kΩ, x%</td>
<td>Panasonic</td>
<td>ERJ-6GEYJ152V</td>
<td>0805</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>54</td>
<td>1</td>
<td>R35</td>
<td>0 R</td>
<td>RES, 0 Ω, x%</td>
<td>Panasonic</td>
<td>ERJ-6GEY0R00V</td>
<td>0805</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>55</td>
<td>1</td>
<td>R34</td>
<td>330</td>
<td>RES, 330 Ω, x%, xW, [PackageReference]</td>
<td>Panasonic Electronic Components</td>
<td>ERJ-6GEYJ331V</td>
<td>0402</td>
<td>Product Page Link</td>
</tr>
<tr>
<td>56</td>
<td>1</td>
<td>U1</td>
<td>MSP430i2040</td>
<td>Texas Instruments</td>
<td>MSP430i2040PW</td>
<td>TSSO10x6-G28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>2</td>
<td>U2, U3</td>
<td>PS8802-1</td>
<td>CEL</td>
<td>PS8802-1</td>
<td>SO-8</td>
<td>Product Page Link</td>
<td></td>
</tr>
<tr>
<td>58</td>
<td>1</td>
<td>U4</td>
<td>Onboard block power supply</td>
<td>CUI Inc</td>
<td>VSK-S1-3R3U</td>
<td>VSK-S1</td>
<td>Product Page Link</td>
<td></td>
</tr>
</tbody>
</table>
7.3 PCB Layout

To download the layer plots, see the design files at TIDM.SERVER-PWR-MON.
7.4 Altium Project

To download the Altium project files, see the design files at TIDM-SERVER-PWR-MON.

Figure 19. Altium Project Image 1

7.5 Gerber Files

To download the Gerber files, see the design files at TIDM-SERVER-PWR-MON.
7.6 **Assembly Drawings**

To download the assembly files, see the design files at [TIDM-SERVER-PWR-MON](#).

![Assembly Drawing Layer 1](Figure 20)
![Assembly Drawing Layer 2](Figure 21)

7.7 **Software Files**

To download the software files, see the design files at [TIDM-SERVER-PWR-MON](#).

8 **References**

1. KP-P3001-C AC Meter Test Set ([link](#))
2. HC 3100 Reference Meter ([link](#))
3. Chroma 61500 Series LOW POWER Programmable AC Source ([link](#))
4. Chroma 66201 and 66202 Reference Meter ([link](#))
5. Chroma 6310/A Series Modular DC Electronic Load ([link](#))

9 **About the Author**

MARS LEUNG received his bachelor of engineering in Hong Kong Polytechnic University and his master of science at the Chinese University of Hong Kong. He has been field application engineer specialized in MCU application support and development; senior smartcard application engineer specialized in smart card payment system definition and implementation; staff engineer specialized in MCU and new module definition; staff engineer in analog system application specialized in digital system; and video processing of dynamic LED backlight control. He is now staff engineer in Texas Instruments’ smart grid application team specialized in embedded electricity metering application.
Appendix A Example Application Code

A.1 Introduction

Project structure:

- `emeter-communication.c` – source code for low level UART communication routines including UART port setup, write and read from UART, interrupt services routine for byte-wise send and receive
- `emeter-dlt645.c` – source code for the polling mode protocol implementation
- `emeter-main.c` – source code for system initialization, main loop, callback functions implementation and interrupt vector placement
- `emeter-meterology-i2041.r43` – embedded metering library object code
- `emeter-setup.c` – source code for low level system initialization
- `emeter-template.h` – source code for configuration
- `metrology-calibration-default.c` – source code to put the user defined default calibration parameter into a proper data structure (should not modify this file)
- `metrology-calibration-template.h` – source code of user defined default calibration parameter
- `emeter-autoreport.c` – source code for performing auto reporting.

---

**NOTE:** To enable auto report support uncomment the \#define AUTOREPORT_SUPPORT definition in `emeter-template.h`.

---
A.2 Preparing the Application Code to Run

1. Launch the IAR5.5 Embedded Workbench IDE and click on File→Open→Workspace.
2. Select “emeters.eww” when prompted to open Workspace.

3. Select the emeter-app-i2041 project tab at the bottom of the Workspace window.
4. Check project options by right clicking the project name and select *Options*… from the pop-up menu (see Figure 23).

Figure 23. Project Tab

5. When the options appear, select *C/C++ Compiler* on the left-hand column. Then select the *Optimizations* tab on the right-hand side and check the optimization settings as shown in Figure 24.

Figure 24. Optimization Options
6. Select FET Debugger on the left-hand column, then select the Setup tab. The EVM uses Spy-Bi-Wire for its code downloading and debugging. Check to make sure the options are as shown in Figure 25.

![Image of Debugger Options]

**Figure 25. Debugger Options**

7. Select the Download tab. Under Flash erase, do not choose Erase main memory and Information memory; this option erases both sets of data and cannot be recovered. Instead, choose Erase main memory as the download option to preserve these factory parameters: system clock calibration, ADC calibration, and internal reference calibration (see Figure 26). However, metrology calibration stored in the main memory, such as VGAIN, IGAIN, PGAIN, and so on, are always erased after downloading.

![Image of Download Options]

**Figure 26. Download Options**

8. Click OK after all of the changes are made.
9. Rebuild the project by right-clicking on the project and select Rebuild All from the pop-up menu (see Figure 27). Three warnings will be reported during rebuilding (see Figure 28), which are safe to ignore. To open the project workspace and modify, compile, and download the code, the user must have IAR Embedded Workbench 5.5 installed with a valid license. If a valid license is not available, the user can still download the object code. See Section A.3 for downloading procedures.
10. Make sure the jumper on J8 is short properly. Connect the 14-pin connector P1 to MSP-FET430UIF by a flat cable as shown in Figure 29.

**CAUTION**

The debugging interface is not isolated. Make sure to properly isolate between the EVM and the PC used for debugging with AC or DC high voltage connected.

---

**NOTE:** Connection to debugging interface is optional for the operation of the EVM. The EVM can operate without a debugger connected.

---

![Figure 29. Connecting EVM and FET](image-url)
11. Click the Download and Debug button to download and debug (see Figure 30).

Figure 30. Code Downloading
12. After successfully completing the download, Figure 31 appears. Click Go to run the application.

Figure 31. Debugger Screen

Figure 32. EVM Running
A.3 **Downloading without an IAR License**

If a valid IAR Embedded Workbench 5.5 license is not available, download the executable code to the board with the following steps using the installed IAR Embedded Workbench 5.5.

1. Open the project workspace as described in Section A.2, Steps 1 through 7. Then connect the board to the MSP-FET430UIF as described in Step 10 in Section A.2.
2. Select *Project*→*Download*→*Download File*… from the menu (see Figure 33).
3. When prompted to select a file, go to the folder `[Submeter i2040 8k_DC_THD_AUTO_OSR_IAR5.5]\emeter-app\emeter-app-i2041\Debug\Exe` and select the file named “emeter-app-i2041.d43” (Figure 34). The executable code will then download to the board.
Appendix B  EVM Operation

B.1  Download Application Code

Download application to the board by using the IAR compiler as described in Appendix A.

B.2  Setting up the PC Software Tool

Unzip the file named "calibrator-runtime.zip" into any folder. A folder named "calibrator-runtime" containing the necessary files to run the software tool will be in that folder. The file named "calibrator-20121120.exe" is the executable file of the software tool. The file named "calibrator-config.xml" contains the setup information for the software tool. Users must make a few edits to this XML file before calibrator-20121120.exe can launch.

Follow these steps to setup the XML to run calibrator-20121120.exe properly:
1. Right click the My Computer icon and select Properties in the pop-up menu.
2. Select the Hardware tab in the System Properties window, then click on the Device Manager to go to its window.

![Image of System Properties Window]

Figure 35. System Properties Window
3. Check the COM port number of the serial port that connects the PC and the EVM.

Figure 36. Device Manager Window
4. Open “calibration-config.xml” in the folder “calibrator-runtime” with a text or XML editor. Go to the line highlighted in Figure 37, put in the COM port number in, and save the file.
B.3 Setup the EVM Hardware

CAUTION
Do not supply power to the EVM until the hardware and software setup is completed.

1. Install jumpers to J5 as shown in Figure 38.
2. Connect AC/DC source to LIVE_IN and NEUTRAL_IN. Connect test load to LIVE_OUT and NEUTRAL_OUT.
3. Connect the serial connector to the PC serial port with a serial cable.
4. Apply AC/DC source power.

Figure 38. Jumpers
B.4 Start Using the EVM

When the EVM has been powered, some of the LEDs will flash or turn on to indicate its operation status while the other LEDs are not used. The user can change the provided source code to make use of all seven LEDs as needed. Table 6 lists how each LED is used.

Table 6. LED Status

<table>
<thead>
<tr>
<th>LED</th>
<th>STATE</th>
<th>INDICATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED1</td>
<td>ON</td>
<td>Background operations running</td>
</tr>
<tr>
<td>LED1</td>
<td>OFF</td>
<td>Background operations completed</td>
</tr>
<tr>
<td>LED2</td>
<td>ON</td>
<td>Negative voltage half cycle</td>
</tr>
<tr>
<td>LED2</td>
<td>OFF</td>
<td>Positive voltage half cycle</td>
</tr>
<tr>
<td>LED3</td>
<td>ON</td>
<td>Not used</td>
</tr>
<tr>
<td>LED3</td>
<td>OFF</td>
<td>Not used</td>
</tr>
<tr>
<td>LED4</td>
<td>ON</td>
<td>Foreground operations running</td>
</tr>
<tr>
<td>LED4</td>
<td>OFF</td>
<td>Foreground operations completed</td>
</tr>
<tr>
<td>LED5</td>
<td>ON</td>
<td>EVM is in AC mode measurement</td>
</tr>
<tr>
<td>LED5</td>
<td>OFF</td>
<td>EVM is not in AC mode measurement</td>
</tr>
<tr>
<td>LED6</td>
<td>ON</td>
<td>EVM is in DC mode measurement</td>
</tr>
<tr>
<td>LED6</td>
<td>OFF</td>
<td>EVM is not in DC mode measurement</td>
</tr>
<tr>
<td>LED7</td>
<td>ON</td>
<td>Active energy pulse pulsing</td>
</tr>
<tr>
<td>LED7</td>
<td>OFF</td>
<td>Active energy pulse idle</td>
</tr>
</tbody>
</table>

To run the readied EVM, launch the software “calibrator-20121120.exe” in the folder “calibration-runtime” to start communicating with the EVM. A window as shown in Figure 39 appears. As defined in the XML file “calibration-config.xml”, meter position 1 is assigned the serial port to communicate with the EVM. The Comms indicator will turn green if communication to EVM from PC is established, and it will flash between red and green when the communication takes place.

![Figure 39. Calibrator Software Startup Window](image-url)
Click on the Comms indicator to show the Meter status window as shown in Figure 40.

This window shows the current reading of the meter. The background of a reading box is gray if the EVM does not support that particular reading. The box turns red if the reading from EVM to that box has a large variance, yellow if the reading from EVM has a fairly low variance, and green if the reading has a low variance.

**NOTE:** The software on PC reads the EVM every second and averages the data read, meaning the update rate is slower than the update rate of the EVM.
At the bottom of this window, there are four buttons.

- The *Meter consumption* button brings up the *Meter consumption* window. This window gives no useful information because the EVM does not support this feature.

- The *Meter calibration factors* button brings up the *Meter calibration factors* window, which shows the current calibration factor values (see Figure 41).

![Figure 41. Meter Calibration Factors Window](image)

- The *Meter features* button brings up the *Meter features* window. This window reports the support feature of the EVM (see Figure 42, which only shows the look and feel of the *Meter features* window, not the exact feature of the EVM).

![Figure 42. Meter Features Window](image)
Known Issues

- Click on the Manual cal button brings up the Manual cal window (Figure 43). In this window, adjust the calibration factor values by entering the percentage error of the reading from the EVM and compare to the reading from the reference meter. The technique and procedure of performing calibration will be discussed in further detail in Appendix C.

![Meter Error Window](image)

**Figure 43. Meter Error Window**

To modify the calibration factor, enter the correction in the percentage error. The percentage error is calculated as follows:

\[
\text{%Error} = \frac{\text{EVM Reading} - \text{Reference Meter Reading}}{\text{Reference Meter Reading}} \times 100\%
\]

Put the percentage error into its corresponding box in the Meter calibration window. Click Update meter to calculate and write the updated calibration values to the EVM. The corresponding values will be reflected on the Meter calibration factor window (Figure 41).

B.5 Known Issues

The calibrator software is legacy software that operates with utility meters that have not been customized completely for embedded metering. The following is a list of known issues with the existing software that will be fixed in the next version of calibrator software customized for embedded metering.

- Neutral monitoring is shown in the Meters features window as a supported feature, which is incorrect. When wire resistance compensation or inlet capacitor compensation is enabled, the calibrator will interpret it as neutral monitoring support.
- Resistance values of wire resistance compensation and capacitance value of inlet capacitor compensation cannot be programmed with calibrator software.
- Voltage AC offset values cannot be written with the calibrator software. The value put into the voltage AC offset box is written to the current AC offset instead. The value put into the current AC offset box has no effect.
- DC offset values cannot be written to the EVM with the calibration software. The current firmware takes the current and voltage DC offset value every time any calibration value is updated.
- The aggregate current in Meter status windows always shows 10.0000 A.
Appendix C  EVM Calibration

C.1  Introduction

The EVM is programmed with calibration values that allow the EVM to give roughly accurate readings; however, the EVM has not been calibrated while shipped. To maximize accuracy and to compensate component and manufacturing tolerance, the EVM must go through a calibration process. This chapter will discuss the techniques, procedures, and steps of calibration.

C.2  Calibration Techniques

The calibration of the EVM is defined based on the front-end interface model as shown in Figure 44.

Figure 44. Front-End Interface Model

This design requires a two-point calibration. VGAIN, IGAIN, PGAIN, VDC_OFFSET, and IDC_OFFSET are parameters that will be calibrated during the process; an estimated value is put into the memory during the design and characterization to help to speed up calibration.

NOTE: Default CAP and RES should set to 0 before calibration.

VAC_OFFSET, IAC_OFFSET, PHASE_CORRECT are parameters that may not need calibration but a characterization would be sufficient for embedded metering application except for a high accuracy of <0.1%.

NOTE: The calibration values are written in one flash page in the EVM, so when a new value needs to be written the whole page is erased. The provided GUI will do the read, modify, and write operations automatically. When using a user calibration facility, read the complete set of calibration values, back them up, update the modified field, and write the complete set back to the EVM.
C.3 Calibration Procedures

C.3.1 Calibration of AC and DC Parameters

Use the following steps to calibrate the AC and DC parameters.

**Calibrating VGAIN**

1. Set to **No/Lowest possible load**.
2. Set **VIN** to line voltage.
3. Calculate the value for VGAIN with the formula

\[
VGAIN_{n+1} = \frac{V_{REF}}{V_{UUT}} \times VGAIN_n
\]

where
- \(VGAIN_{n+1}\) is the new voltage calibration factor
- \(VGAIN_n\) is the original voltage calibration factor
- \(V_{REF}\) is the reference meter voltage reading at the voltage set for VGAIN calibration
- \(V_{UUT}\) is the unit under test voltage reading at the voltage set for VGAIN calibration

or, if percentage error is used (as with the provided calibration software),

\[
\%Error = \left(1 - \frac{V_{UUT}}{V_{REF}}\right) \times 100\%
\]

4. Write and apply the calibrated VGAIN.

**Calibrating IGAIN**

1. Set **VIN** to line voltage.
2. Set to **High / Highest possible load**.
3. Calculate IGAIN value with the formula

\[
IGAIN_{n+1} = \frac{I_{REF}}{I_{UUT}} \times IGAIN_n
\]

where
- \(IGAIN_{n+1}\) is the new current calibration factor
- \(IGAIN_n\) is the original calibration factor
- \(I_{REF}\) is the reference meter current reading at the current set for IGAIN calibration
- \(I_{UUT}\) is the unit under test current reading at the current set for IGAIN calibration

or, if percentage error is used (as with the provided calibration software),

\[
\%Error = \left(1 - \frac{I_{UUT}}{I_{REF}}\right) \times 100\%
\]

4. Write and apply the calibrated IGAIN.

**Calibrating PGAIN**

1. Use the same conditions as **Calibrating VGAIN** and **Calibrating IGAIN** with the power factor = 1.
2. Note the percentage error on voltage at this point.
3. Calculate PGAIN gain so that power is of the same percentage error as voltage at this point:

\[ PGAIN_{n+1} = \frac{P_{REF}}{P_{UUT}} \times PGAIN_n \times (1 - \% \text{Error of } V_{UUT} \text{ at this load}) \]

where

- \( PGAIN_{n+1} \) is the new power calibration factor
- \( PGAIN_n \) is the original power calibration factor
- \( P_{REF} \) is the reference meter power reading at the power set for PGAIN calibration
- \( P_{UUT} \) is the unit under test power reading at the power set for PGAIN calibration

or, if percentage error is used (as with the provided calibration software),

\[ \% \text{Error} = (1 + \% \text{Error}) (1 - \% \text{Error of } V_{UUT} \text{ at this load}) \]

4. Write and apply the calibrated PGAIN.

C.3.2 Calibration of Compensation Resistance and Capacitance

After calibrating VGAIN, IGAIN, and PGAIN, follow these steps to calibrate the compensation to wire resistance and EMI capacitance.

Calibrating RES

1. Calculate RES with the given equation:

\[ R_{WIRE} = \frac{V_{REF}(I_{\text{max}}) - V_{UUT}(I_{\text{max}})}{I_{\text{max}} - I_{\text{min}}} \approx \frac{V_{REF}(I_{\text{max}}) - V_{UUT}(I_{\text{max}})}{I_{\text{max}}} \]

where

- \( R_{WIRE} \) is the estimated wire resistance
- \( V_{REF}(I_{\text{max}}) \) is the reference meter voltage reading at the current set for IGAIN calibration
- \( V_{UUT}(I_{\text{max}}) \) is the unit under test voltage reading at the current set for IGAIN calibration
- \( I_{\text{max}} \) is the current set for IGAIN calibration

2. Write and apply the calibrated RES.

NOTE: The resistance is in 1/256-Ω units.

Calibrating CAP

1. Set to No / Lowest possible load.
2. Set VIN to low line voltage.
3. Calculate CAP with the given equation:

\[ C = \frac{1}{2\pi fV^2} \left( \sqrt{P_{\text{apparent}_\text{REF}}^2 - P_{\text{active}}^2} - \sqrt{P_{\text{apparent}_\text{UUT}}^2 - P_{\text{active}}^2} \right) \]

where

- \( C \) is the estimated EMI filter capacitance
- \( V \) is the voltage set for calibration of C
- \( P_{\text{apparent}_\text{REF}} \) is the apparent power reading of the reference meter at the setting for this calibration
- \( P_{\text{apparent}_\text{UUT}} \) is the apparent power reading of the unit under test at the setting for this calibration
- \( P_{\text{active}} \) is the active power reading of the reference meter (suppose ut is already calibrated to be the same as the active power reading of UUT)

4. Write and apply the calibrated CAP.

NOTE: The capacitance is in 1/64-μF units.
C.3.3 Calibration of Current AC Offset

The current AC offset is the result of noise pickup, and the offset generated on the shunt resistor circuit causes an illusion of having a finite current flowing when there is actually not current flowing through the shunt. Although this noise current does not affect the power reading’s accuracy, this illusion contributes to the current reading and its accuracy, especially when the current is small. To offset this miscalculation, the EVM firmware has the mechanism to remove this from the current reading. The steps to calibrate this current offset are as follows:

1. Apply nominal voltage to make sure the EVM operates.
2. Remove all loading from the EVM.
3. Take multiple current readings (for example, 100) and take an average as \( I_{\text{NOISE}} \) (in A).
4. Calculate the current AC offset value with the equation

\[
I_{\text{AC OFFSET}} = \text{int}\left( I_{\text{NOISE}} \times \left( \frac{1024 \times 10^6}{\text{IGAIN}} \right)^2 \right)
\]

(23)

**NOTE:** This is a big number even in the case of a few mA of noise.

5. Write and apply the calibrated \( I_{\text{AC OFFSET}} \).

C.3.4 Calibration of Voltage AC Offset

In most cases, the voltage AC offset rarely affects the voltage reading and does not require calibration.

C.3.5 Calibration of Phase Correction

1. Set the test set to generate rated voltage and set to calibration current (for example, 5 A).
2. Make sure calibrations are complete for PGAIN (at PF = 1).
3. Set the test set to output at power factor 0.5 (+ or – is not important at this point).
4. Note the power error.
5. Switch the test set to output at power factor 0.5 in the other direction to Step 3.
6. Note the power error.
7. At this point, both power errors should be approximately the same deviation but a different direction from the calibrated power error at PF = 1.
   • For example, at PF = 1, the calibrated error is 0.1%. If at PF = 0.5, the power error reads about 0.5%. Then at PF = –0.5, the power error should read about –0.3%.
8. Adjust the phase correction with time deviation from the current phase correction such that the power errors at PF = ±0.5 are minimized.
   • For example, if the current phase correction is 13 μs and 11 μs is desired, enter –2 into the phase correction box of the manual calibration window.

C.3.6 Calibration of DC Parameters

This EVM design calibrates the AC and DC measurement parameters simultaneously. The DC measurement parameters update automatically in the last step of calibration.

In fact, whenever the complete set of calibration values is read, the most up-to-date DC measurement parameters are also included in the set. When other parameters update, the DC measurement parameter also update to the most current value. However, the value is most accurate when current is low (best with not current at all). As such, update the DC measurement parameter after the \( I_{\text{AC OFFSET}} \) calibration.

**NOTE:** This may not be a user friendly way of setting DC measurement parameters. The procedure of having the best DC measurement parameters will be modified and improved when the embedded metering customized calibration software is released.
Appendix D  EVM Specification

- Voltage operating range (with supplied power supply): 85 to 265-V AC, 120 to 380-V DC
- Sample rate: 8000 Hz
- Sampling bit depth: 24 bits
- Polling report supported
- Update rate: Four AC cycles (AC mode), 80 ms (DC mode)
- UART communication data rate: 9600 bps
- AC/DC measuring mode switching: Four AC cycles (AC to DC), 80 ms (DC to AC)
- Measurements: RMS voltage, RMS current, active power, reactive power, apparent power, power factor, line frequency, and temperature
- Measurement voltage range: 0 to 265 $V_{RMS}$ AC, 0 to $\pm380$-V DC (using reference design circuit and component values)
- Measurement current range: 0 to 15 $A_{RMS}$ AC, 0 to $\pm22.5$-A DC (using reference design circuit and 0.5-mΩ shunt values)
- Voltage resolution: 1 mV
- Current resolution: 1 µA
- Active Power resolution: 1 mW
- Reactive/apparent power resolution: 1 mW
- Power factor resolution: 0.001
- Frequency resolution: 0.01 Hz
Appendix E  Running on MSP430i2040 and MSP430i2041

The example IAR project has been configured for MSP430i2041. To run on MSP430i2040, follow these steps once:

1. Open the workspace. After launching IAR 5.5, select *File→Open→Workspace.*

![Figure 45. IAR 5.5 Launch Window](image-url)
When prompted to open the project, select _emeters.eww_ from the project directory of the example code.

![Open Workspace Window](image1)

Figure 46. Open Workspace Window

2. Set the option. Right click on the project _emeter-app-i2041_ and select _Options_...  

![Workspace Options](image2)

Figure 47. Workspace Options
In the **Options** window, click on **General Options** on the left-hand column and then select the **Target** tab. Then, in the **Device** section, click on the right-hand side button of the entry box and select **MSP430Ixxxx Family → MSP430I2040**.

![Figure 48. Options Window](image)

Click on **Linker** in the left-hand column and select the **Config** tab. Then click on the right-hand button in the **Linker configuration file** box.

![Figure 49. Config Tab](image)
Select `Ink430i2040_temp.xcl` when prompted and click `Open`.

![Image](image1.png)

Figure 50. Selecting Default XCL File

When brought back to the `Options` window, click `OK`.

![Image](image2.png)

Figure 51. Finishing the Setting Changes
When brought back to the main screen, select **File→Save** to save the setting.

![Figure 52. Saving the Setting Changes](image)

The project is now set for run on MSP430i2040. To have the project to run back on MSP430i2041, follow the same steps except select **MSP430ixxxx Family→MSP430i2041** in the *Options* window and select **lnk430i2041_temp.xcl** when prompted in the *Linker configuration file* box.
## Revision History

**Changes from Original (August 2014) to A Revision**

<table>
<thead>
<tr>
<th>Change Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Added Appendix E to explain how to run a project on MSP430i2040</td>
<td>44</td>
</tr>
</tbody>
</table>

---

**NOTE:** Page numbers for previous revisions may differ from page numbers in the current version.
TEXAS INSTRUMENTS INCORPORATED

IMPORTANT NOTICE FOR TI REFERENCE DESIGNS

Texas Instruments Incorporated (“TI”) reference designs are solely intended to assist designers (“Buyers”) who are developing systems that incorporate TI semiconductor products (also referred to herein as “components”). Buyer understands and agrees that Buyer remains responsible for using its independent analysis, evaluation and judgment in designing Buyer’s systems and products.

TI reference designs have been created using standard laboratory conditions and engineering practices. TI has not conducted any testing other than that specifically described in the published documentation for a particular reference design. TI may make corrections, enhancements, improvements and other changes to its reference designs.

Buyers are authorized to use TI reference designs with the TI component(s) identified in each particular reference design and to modify the reference design in the development of their end products. HOWEVER, NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY THIRD PARTY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT, IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI components or services are used.

Information published by TI regarding third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties have executed an agreement specifically governing such use. Only those TI components that TI has specifically designated as military grade or "enhanced plastic" are designed and intended for use in military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components that have not been so designated is solely at Buyer’s risk, and Buyer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2014, Texas Instruments Incorporated